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改訂履歴
次の表に、 この文書の改訂履歴を示します。
 

日付 バージ ョ ン 改訂内容

2010 年 3 月 15 日 1.0 初期リ リース

2011 年 3 月 1 日 13.1 ISE 13.1 の消費電力ツール向けに情報を更新
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Virtex-6 および Spartan-6 消費電力ツール 
チュート リアル

概要

このチュート リ アルでは、 ザイ リ ンクス消費電力ツールを使用して消費電力を正確に予測する方法

を示します。 このチュート リ アルでは XPower Esitimator (XPE) スプレッ ドシートおよび XPower
Analyzer (XPA) の両方で使用できる  Virtex®-6 および Spartan®-6 の単純なデザインを使用して、

デザイン フローでどのよ うに消費電力ツールを使用するか解説していきます。 また、 ISE インプ リ

メンテーシ ョ ン ツールに含まれる消費電力の最適化オプシ ョ ンについても説明します。

ザイ リ ンクス消費電力ツールは、デザイン フローのさまざまな段階で使用できます。 これらのツー

ルでは、 デザイン前の段階の消費電力予測からデザインが完全にインプ リ メン ト された時点の消費

電力予測までを実行できます。消費電力ツールではデザイン フロー全体を通して情報を提供できる

ので、 次の作業に使用できます。

· デバイス選択

· ボード設計

· システムの信頼性

· 消費電力予測、 解析、 および最適化

FPGA の消費電力

ザイ リ ンクスでは、 縮小し続ける技術に伴う消費電力における課題を克服できるよ うに常に革新し

ています。 ザイ リ ンクスでは FPGA の消費電力が FPGA ユーザーにとって最大の懸念事項の 1 つ
であるこ とを承知しています。 ザイ リ ンクスの消費電力ツールを使用する と、 任意のデザインで消

費電力予測および解析を実行できます。消費電力予測および解析は、縮小されたプロセス  ジオメ ト

リへの移行によ り  FPGA のロジッ ク集積度およびパフォーマンスが増加するため、 さ らに重要に

なってきています。 

FPGA の総消費電力は、 次の 2 つを加算したものです。

· スタティ ッ ク消費電力 : 主にデバイス内のト ランジスタの リーク電流に起因します。 リーク電

流はソース ・ ドレイン間またはゲート酸化のいずれかから発生し、 ト ランジスタが論理的にオ

フのと きでも発生します。

· ダイナミ ッ ク消費電力 : デバイスのコアまたは I/O に含まれるデザイン アクティ ビティおよ

びスイ ッチング アクティビティに関係しています。 ダイナミ ッ ク消費電力は、 ノードのキャパ

シタンス、 電源、 およびスイ ッチ頻度によ り決定します。

ザイ リ ンクスの消費電力の精度は、 次の 2 つの要素に依存しています。

· ツールに含められるデバイス  データ  モデルおよびデバイス特性

http://japan.xilinx.com
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· ユーザーによ り ツールに入力される入力

アプリケーシ ョ ンで正確な消費電力予測を実行するには、 可能な限り現実的な情報を入力してくだ

さい。 保守的過ぎたり、 デザインに対する知識が不足しているよ う な状態でデザインの特定の側面

をモデル化する と、 予測結果が非現実になる可能性があ り ます。

チュート リアル デザイン情報

このチュート リ アルで使用されるデザインは、機能的なデザインではあ り ません。このデザインは、

消費電力ツールの機能を示してその使用方法を推奨するためのみに使用されます。このデザインは、

ISE で消費電力の最適化オプシ ョ ンを使用せずに、 合成およびインプリ メンテーシ ョ ンが実行され

ています。

XPA の入力ファイルと して使用される  SAIF (シ ミ ュレーシ ョ ン アクティビティ ) ファ イルは、ISim
で生成されています。 SAIF ファ イルは、 デザイン シ ミ ュレーシ ョ ンで作成されるスティ ミ ュラス

です。 ISim を使用した SAIF の生成に関する詳細は、 『ISim ユーザー ガイ ド』 (UG660) を参照し

てください。

XPE (XPower Estimator) を使用した消費電力予測

XPower Estimator (XPE) スプレッ ドシートは、通常プロジェク トの設計前と インプ リ メンテーシ ョ

ン前の段階で使用される消費電力予測ツールです。XPE では、アーキテクチャの評価およびデバイ

スの選択が支援され、 適切な電源およびアプ リ ケーシ ョ ンで必要になる可能性がある熱管理コン

ポーネン ト を選択する際に役立ちます。

インプ リ メンテーシ ョ ン前のツールなので、 デザインの RTL 記述が未完成であるデザイン サイク

ル初期段階で使用できます。 インプ リ メ ンテーシ ョ ン後には、 ISE Design Suite に含まれている

XPower Analyzer (XPA) ツールを使用して、 精度の高い消費電力予測および解析を実行できます。

XPE はスプレッ ドシート なので、 書き込み可能な (保護されていない) セクシ ョ ンでマイ ク ロ ソフ

ト  Excel の機能すべてを使用できます。

このチュート リ アルは、 XPE の徹底的概要を示すものではなく、 基本的な XPE 機能の例を紹介し

て、 デザインで消費電力を迅速に実行できるよ うにするこ とを目的にしています。 XPE の詳細は、

『XPower Estimator ユーザー ガイ ド』 (UG440) を参照してください。 

正確な XPE 予測を実行するには、 デザインで使用されるデバイス  リ ソース数を予測する必要があ

り ます。予測をどのよ うに実行したらよいか不明の場合は、 ISE に含まれているサンプル デザイン

を実行してマップ レポート  ファ イルを確認してみてください。 このレポートには、 リ ソースの使

用量情報が含まれています。

XPE では、 デバイス  アーキテクチャに含まれる各種コンポーネン ト  (I/O、 BRAM、 および DCM
など) がタブ形式で表示されます。 XPE で表示されるタブ数は、 デバイスのアーキテクチャによっ

て異なり ます。 たとえば、 このチュート リ アルでは、 選択したデバイスに MGT 回路が含まれてい

ないため、 MGT のタブは表示されません。

このチュート リ アルでは、バージ ョ ン 13.1 の XPA を使用します。次に、XPE を使用して消費電力

解析を実行する手順を示します。 このチュート リ アルでは、 Spartan-6 または Virtex-6 のデザイン

を使用できます。

http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=user+guides&sub=j_ug440.pdf
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=user+guides&sub=j_ug440.pdf
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&ver=13.1&topic=sw+manuals&sub=plugin_ism.pdf
http://japan.xilinx.com
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XPE (XPower Estimator) を使用した消費電力予測

手順 1 : XPE スプレッ ドシート をダウンロード します。

ターゲッ ト  デバイスの最新のスプレッ ドシートおよびチュート リ アル デザイン ファ イルをダウン

ロード します。

XPE スプレッ ドシートは、 消費電力ソ リ ューシ ョ ン ウェブページからダウンロードできます。

http://japan.xilinx.com/power

このチュート リ アルでは、 バージ ョ ン 13.1 のスプレッ ドシート を使用します。

· Virtex-6 : Virtex5_Virtex6_XPE_13_1.xls

または

· Spartan-6 : Spartan3a_Spartan6_XPE_13_1.xls

デザイン ファ イルは、 チュート リ アル ページからダウンロードできます。

http://japan.xilinx.com/support/documentation/dt_ise13-1_tutorials.htm

手順 2 : デザイン情報のインポート  (可能な場合)
MRP (マップ レポート ) ファ イルを Virtex-6 または Spartan-6 チュート リ アル デザイン （チュート

リ アル ページよ り入手可能) の作業ディ レク ト リから インポート します。XPE スプレッ ドシートで

[Import] ボタンをク リ ッ ク し、ダイアログ ボッ クスの [Files of type] で [Map Report (*.mrp)] を選

択します。 MRP ファ イルを選択する と、 自動的にスプレッ ドシートにデザイン リ ソースが読み込

まれます。

メモ : ほとんどの場合で、デザインが ISE でインプリ メン ト される前に情報を  XPE に入力するこ と

になるため、XPE にインポートできる  MRP ファ イルはあ り ません。このチュート リ アルでは、XPE
スプレッ ドシートに一部の初期情報を含めるために MRP ファ イルをインポート しました。

チュート リ アル用マップ レポートのファ イル名

· Virtex-6 : V6_tutorial_top_16bit_map.mrp (XPE にインポートするマップ レポート )

· Spartan-6 : S6_tutorial_top_16bit_map.mrp (XPE にインポートするマップ レポート )

メモ : 任意のデザインですでに XPE を使用しており、 XPE のバージ ョ ンをアップグレードする場

合は、[Import] ボタンをク リ ッ ク してからダイアログ ボッ クスの [Files of type] で [XPE Workbook
(*.xls*)] を選択します。 インポートするファ イルの種類に .xls を選択した場合は、 以前に作業した

XPE スプレッ ドシートの情報がアップグレード されたスプレッ ドシートに読み込まれます。

手順 3 : 環境データの入力

[Summary] タブで、 [Device] 情報を確認し、 [Environment] に次のデータを入力します。

· [Ambient Temp] = 25°C

· [Airflow] = 0

· [Heat Sink] = None

図 1 : [Import] ボタン

http://japan.xilinx.com
http://japan.xilinx.com/power
http://japan.xilinx.com/power
http://japan.xilinx.com/support/documentation/dt_ise13-1_tutorials.htm
http://japan.xilinx.com/support/documentation/dt_ise13-1_tutorials.htm
http://japan.xilinx.com/support/documentation/dt_ise13-1_tutorials.htm
http://japan.xilinx.com/support/documentation/dt_ise13-1_tutorials.htm
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メモ : FPGA のスタティ ッ ク消費電力は、 環境設定に大幅に影響を受けるので、 ボード環境とボー

ド  データをできる限り一致させる必要があ り ます。ザイ リ ンクスの消費電力ツールは、What If? 解
析を実行して、 ボードに最適な熱ス ト ラテジを特定する際に非常に便利です。

図 2 : Virtex-6 デザインのデバイスおよび環境設定

http://japan.xilinx.com
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XPE (XPower Estimator) を使用した消費電力予測

手順 4 : アクテ ィ ビテ ィ  レートの設定

各タブ (Logic、IO、BRAM、DSP) それぞれにト グル レート を設定できます。この場合は、[Summary]
タブで [Set Default Activity Rates] ボタンをク リ ッ ク します。 デフォル ト では、 ロジッ ク、 DSP、
および I/O に対して ト グル レートが 12.5 ％ に設定されます。

通常、 ロジッ クが多く使用されるデザインは、同期クロ ッ クの 12.5% 程度で動作します (XPE では

デフォルト値に 12.5% を使用)。 ワース ト ケース予測には、 20% のト グル レート を使用できます。

平均ト グル レートが 20% 以上になるこ とは非常にまれです。 演算量の多いモジュールの場合、 ト

グル レートは最大 50% まで許容できるよ うに見えますが、 これは典型的なワース ト ケース条件に

なり ます。 乗塁算などがその例です。 また、 ランダム入力データの ト グル レートは 50% でモデル

するのが一般的です。 ト グル レートが 100% とはどのよ うなこ とかを理解するには、データ入力が

High に接続され、 常にイネーブルにされている ト グル フ リ ップフロ ップ (TFF) を使用する場合を

考えてみてください。 このフ リ ップフロ ップの T 出力はすべてのクロ ッ ク  エッジで ト グルします。

平均ト グル レート を 100% にできるデザインは、 ほとんどあ り ません。

手順 5 : クロック  ネッ トの周波数の設定

スプレ ッ ド シー ト で全体的な ク ロ ッ ク周波数を設定し ます。 [Summary] タブで [Set Default
Activity Rates] ボタンをク リ ッ ク し、 ダイアログ ボッ クスの [All Clock Nets] を 200MHz (デフォ

ルト )  に設定します。

図 3 : Spartan-6 デザインのデバイスおよび環境設定

図 4 : [Set Default Activity Rates] ボタン

http://japan.xilinx.com
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メモ : デザインでクロ ッ ク  ネッ トが定義されていない場合は、 値を変更しても影響しません。

ツールバー ボタンを使用する と、 クロ ッ ク、 ロジッ ク、 I/O、 ブロ ッ ク  RAM、 および DSP エレ メ

ン ト など、関連するすべてのデザイン エレ メン トのクロ ッ ク周波数を設定できます。すべてのエレ

メン トに 1 つのクロ ッ ク周波数を設定するこ とは現実的ではあ り ませんが、個々のエレ メン トは各

タブで調整できます。

手順 6 : デザイン情報の入力

Virtex-6 デザインで作業している場合は、 [MMCM] タブでデザインに含まれる  2 つの MMCM コ
ンポーネン トに対して、 ク ロ ッ ク周波数、乗算カウンター数、および ク ロ ッ ク  0 の分周率を設定し

ます。

1 つ目の MMCM を次の値に設定します。 

· [Clock (MHz)] = 200MHz

· [Multiply Counter] = 10

· [Clock 0 Divide] = 5 

· ほかのセルはデフォルト値のままにします。

2 つ目の MMCM を次の値に設定します。 

· [Clock (MHz)] = 33MHz

· [Multiply Counter] = 25

· [Clock 0 Divide] = 25

· ほかのセルはデフォルト値のままにします。

この時点で [Summary] タブに表示される  Virtex-6 デザインの消費電力値は、 次の図のよ うにな り

ます。

http://japan.xilinx.com
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Spartan-6 デザインで作業している場合は、 [PLL] タブでデザインに含まれる  PLL コンポーネン ト

のク ロ ッ ク周波数、 乗算器カウンター数、 およびクロ ッ ク  0 の分周率を設定します。

PLL を次の値に設定します。

· [Clock (MHz)] = 33MHz

· [Multiply Counter] = 25

· [Clock 0 Divide] = 25

· ほかのセルはデフォルト値のままにします。

この時点で [Summary] タブに表示される  Spartan-6 デザインの消費電力値は、次の図のよ うになり

ます。

図 5 : XPE の FPGA 消費電力サマリ  (Virtex-6 FPGA の場合)

http://japan.xilinx.com
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手順 7 : デザイン データの変更

[Import] 機能によ り マ ップ レポー ト  (MRP) フ ァ イルのデータがインポー ト され、 [CLOCK]、
[LOGIC]、 [IO]、 [BRAM]、および [DSP] タブに含まれているデザイン エレ メン トの概算値が入力

されました。これらのエレ メン トがどのよ うにデザインで使用されるかをよ く理解している場合は、

予測の精度を向上できます。 MRP ファ イルから さらにデータを抽出して、 XPE スプレッ ドシート

の値を調整する と、 消費電力予測の精度を高めるこ とができます。

メモ : MAP で -detail オプシ ョ ンを使用して、詳細なマップ レポート を生成する と、デザインの詳

細情報を取得できます。 MRP ファ イル (マップ レポート ) からデータをインポート した後に、 この

情報を使用して XPE のデザイン エレメン トの値を変更します。 このオプシ ョ ンの詳細は、『コマン

ド  ラ イン ツール ユーザー ガイ ド』 (UG628) を参照して ください。

メモ : ISE で  xpwr -xpe コマンド  ラインを使用する と、 XPE にインポート可能な特定のデザイン

情報を含む .xpe ファ イルが生成されます。XPower Analyzer (XPA) のデザイン情報を XPE にイン

ポートする際の詳細は、 『XPower Estimator ユーザー ガイ ド』 (UG440) を参照してください。

Virtex-6 デザインで作業している場合は、 次のエレ メン トの値を変更します。

· [CLOCK] タブで クロ ッ ク使用を 2 つのクロ ッ クのみに簡素化します。 

¨ 1 つ目のクロ ッ クは、 次のよ うに設定します。 

- [Frequency (MHz)] = 200MHz

- [Fanout] = 68

図 6 : XPE の FPGA 消費電力サマリ  (Spartan-6 FPGA の場合)
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¨ 2 つ目のクロ ッ クは、 次のよ うに設定します。 

- [Frequency (MHz)] = 33MHz

- [Fanout] = 63

· [LOGIC] タブで [Toggle Rate] をこのデザインの平均予測値である  19% に変更します。

· [IO] タブで LVCMOS I/O の [Clock (MHz)] (ク ロ ッ ク周波数) を 33MHz に変更し、両方の I/O
タイプの [Toggle Rate] をこのデザインのすべての I/O に対する平均予測値である  14% に変更

します。

· [DSP] タブでは、 すべての DSP コンポーネン トの [Toggle Rate] を平均予測値である  1.5% に
変更します。

すべての値を入力または更新した後には、 [Summary] タブで消費電力結果を確認できます。次の図

に、 Virtex-6 デザインの変更後の消費電力予測を示します。

Spartan-6 デザインで作業している場合は、 次のエレ メン トの値を変更します。

· [CLOCK] タブで クロ ッ ク使用を 2 つのクロ ッ クのみに簡素化します。

¨ 1 つ目のクロ ッ クは、 次のよ うに設定します。 

- [Frequency (MHz)] = 200MHz

- [Fanout] = 63

図 7 : 更新された FPGA 消費電力サマリ  (Virtex-6 FPGA の場合)

http://japan.xilinx.com
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¨ 2 つ目のクロ ッ クは、 次のよ うに設定します。

- [Frequency (MHz)] = 33MHz 

- [Fanout] = 28

· [LOGIC] タブで [Toggle Rate] を平均予測値の 19% に変更します。

· [IO] タブで LVCMOS I/O の [Clock (MHz)] (ク ロ ッ ク周波数) を 33MHz に変更し、両方の I/O
タイプの [Toggle Rate] をこのデザインのすべての I/O に対する平均予測値である  14% に変更

します。

すべての値を入力または更新した後には、 [Summary] タブで消費電力結果を確認できます。次の図

に、 Spartan-6 デザインの変更後の消費電力予測を示します。

データの入力後に選択したグレードの熱制限内でデバイスが動作している場合は、XPE でレポート

された消費電力を使用して、 デザインの電源レールを決定できます。 入力したデータの信頼性が高

くない場合は、 FPGA の消費電力システムを下回って設計しないよ うに数値を多少上げるこ とが可

能です。 ただし、 データが十分に信頼できる場合は、 数値を上げる必要はあ り ません。

XPE は、デザイン構想の初期段階で消費電力バジェッ ト を予測するために主に使用しますが、デザ

イン段階後半でも正確な消費電力予測を取得したり  (手順 7 : デザイン データの変更を参照)、 ワー

ス ト ケースの消費電力解析を実行するのに使用できます。詳細は、 『XPower Estimator ユーザー ガ
イ ド』 (UG440)、 『消費電力手法ガイ ド』 (UG786)、 およびホワイ ト  ペーパー 『Seven Steps to an
Accurate Worst-Case Power Analysis Using Xilinx Power Estimator (XPE) 』 (WP353) を参照して

ください。

図 8 : 更新された FPGA 消費電力サマリ  (Spartan-6 FPGA の場合)
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ISE の消費電力削減オプシ ョ ン

消費電力結果の主な解釈ポイン ト

· XPE ではすべての電源で使用される消費電力の合計がレポート されます ([Summary] タブの

[Power Supply] セクシ ョ ン)。 この表には、 オンボード電力供給に必要なすべての消費電力が

含まれています。

· XPE では、すべての電源レールでオンチップで消費される電力がレポート されます ( [On-Chip
Power] 表)。 この表では、各種 FPGA リ ソースで消費される電力の内訳が表示されます。また、

その割合も表示されます。 このパネルは、 デバイスで消費される電力量を判断するのに役立ち

ます。 また、 目標電力バジェッ ト を達成するために、 消費電力の最適化を実行できるデザイン

箇所を特定する際にも役立ちます。

· XPE では、 熱データも  [Summary] 表にレポート され、 パッケージ特性に関連して予測された

FPGA のジャンクシ ョ ン温度および熱電力 (オンチップ消費電力) が表示されます。

ISE の消費電力削減オプシ ョ ン

ISE デザイン フローで使用される消費電力最適化オプシ ョ ンの効果は、デザインによって異なり ま

す。 合成およびインプ リ メンテーシ ョ ンで-power オプシ ョ ンを使用する と、 平均して約 10% の消

費電力を削減でき、 若干のランタイム ペナルティ  (約 15%) とパフォーマンス低下が発生するだけ

です。 このチュート リ アルで使用するデザインは比較的小さいため、 ダイナミ ッ ク消費電力がスタ

ティ ッ ク消費電力よ りかなり低くなっています。 このよ う な状況下では、 合成およびインプ リ メン

テーシ ョ ンで使用できる消費電力最適化オプシ ョ ンは効果があ り ません。

ISE には、 消費電力の削減に役立つプロセス  プロパティが複数あ り ます。 これらのプロパティは、

合成およびマップのプロセスで設定できます。

メモ : 各ツールのプロパティを変更する代わりに、 消費電力を最適化するための定義済みインプ リ

メンテーシ ョ ン ス ト ラテジを使用するこ と も可能です。

合成での消費電力削減

合成で -power オプシ ョ ンを使用する と、消費電力を削減できます。 ISE の [Power Reduction] プロ

パティを使用する と、 XST でデザインの消費電力を最低限に抑えるこ とができます。 マク ロ  プロ

セスでは、 消費電力が最低限になるよ うにファンクシ ョ ンがインプ リ メン ト されます。 

ISE で合成プロパティを表示するには、 次を実行します。

1. [Processes] ペインで [Synthesize] を右ク リ ッ ク し、 [Process Properties] をク リ ッ ク します。

2. [Process Properties - Synthesis Options] ダイアログ ボッ クスで  [Power Reduction] が [On] に
設定されているか確認します。

マップでの消費電力削減

マップで -power high オプシ ョ ン (ISE の [Power Reduction] プロパティ ) を [On] に設定する と、

消費電力を削減できます。 このプロパティでは、各クロ ッ ク  サイクルの出力に関与しないロジッ ク

をディ スエーブルにし、 デザイン アクテ ィ ビティ を最小限に抑えるためにゲーティ ング ロジッ ク

を除去します。

また、 スイ ッチイング アクテ ィビテ ィ  ファ イルを指定して消費電力を最適化できます。 スイ ッチ

ング アクティビティ  ファ イルは、 -activityfile オプシ ョ ン ([Power Activity File] プロパティ ) で指

定できます。

マップには、 -global_opt オプシ ョ ン ([Global Optimization] プロパティ ) という消費電力削減オプ

シ ョ ンもあ り ます。 このオプシ ョ ンでは、 タイ ミ ング ド リブンのパッ クおよび配置中にデザインで

http://japan.xilinx.com
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消費される電力を削減するよ うに配置が最適化されます。グローバル最適化には、ロジッ クの再マッ

プおよびト リ ミ ング、 ロジッ クおよびレジスターの複製、最適化、およびト ラ イステート  ロジッ ク

の置き換えが含まれます。 デザインによっては、 このオプシ ョ ンを使用するこ とで消費電力を削減

できます。 これらの作業に余分に時間がかかるため、 マップのランタイムが長くなり ます。 デフォ

ルトでは off に設定されています。 このオプシ ョ ンの詳細は、『コマンド  ラ イン ツール ユーザー ガ
イ ド』 (UG682) を参照してください。

XPower Analyzer (XPA) を使用した消費電力解析

XPA では、 実デザイン データを解析します。 ISE でデザインをインプ リ メ ン ト した後に配置配線

(PAR) で出力された NCD ファ イルを使用します。 XPA では、ベクターレス予測アルゴ リズムがあ

り、 ノードのアクテ ィ ビティ  レートがデザイン ファ イルで定義されていなかったり、 別の方法で

も指定されていないと きに、 これらのノードにアクテ ィ ビテ ィ  レー ト を割り当てる こ とができま

す。 ただし、 精度の高い消費電力解析を取得するには、 シ ミ ュレーシ ョ ン アクテ ィ ビティ  ファ イ

ル (SAIF または VCD) を使用して ください。 消費電力解析で最新の特性データを使用できるよ う、

最新のバージ ョ ンの ISE に含まれる  XPA を使用してください。

XPA は、 デザインの消費電力解析に使用します。 XPA が使用されるデザイン段階では、 ISE プロ

ジェク トで配置配線 (PAR) が正し く完了して NCD 出力ファイルが生成されています。消費電力予

測では、 XPA でどのデザイン ファ イルが使用されたか理解するこ とが重要です。 このチュート リ

アルでは、SP601 ボード上で Spartan-6 デザインまたは Virtex-6 デザインのいずれかを使用して消

費電力予測を実行します。 これらのデザイン ファ イルは、 チュート リ アル ページからダウンロー

ドできます。

XPA は、 ISE Project Navigator のプロジェク ト内からスタンドアロン グラフ ィカル ユーザー イン

ターフェイス  (xpa シェル コマンド ) と して起動するか、 バッチ コマンド  ラ イン (xpwr) と して起

動するか、 または PlanAhead から起動できます。 XPA の GUI は、 コマンド  ラインに 「xpa」 と入

力する と開く こ とができます。 テキス ト形式の消費電力レポート を生成する場合は、 「xpwr」 と入

力します。 コマンド  シェルに 「xpwr」 と入力する とすべてのオプシ ョ ンが表示されます。

XPA は ISE の [Processes] ペインの [Place & Route] プロセスの下にあ り ます。

XPA を PlanAhead から起動する場合は、 Flow Navigator で [Implement Design] を展開します。

[Implement Design] タスク  リ ス トから  [Launch XPower Analyzer] コマンドを選択します。

XPA でのレポートの精度を向上するよ う、 オプシ ョ ンのデザイン ファ イルも読み込むこ とができ

ます。 たとえば、 Project Navigator では次を実行できます。

1. [Processes] ペインで [Place & Route] を展開して [Analyze Power Distribution (XPower
Analyzer)] を右ク リ ッ ク します。

2. [Process Properties] をク リ ッ ク します。

3. [Process Properties - XPower Analyzer Properties] ダイアログ ボッ クスでファイルを指定します。

また、 スタンドアロン ツールには、デザインを読み込む際にこれらのファイルを含めるオプシ ョ ン

があ り ます。 [Open Design] ダイアログ ボッ クスでこれらのファイルを指定します。

次が使用可能な入力ファイルです。

· NCD : XPA で必須な配置配線 (PAR) で出力されるファ イル。

· 設定ファイル : オプシ ョ ン ファ イル。設定ファイルには、XPower Analyzer セッシ ョ ンで保存

されたアプ リ ケーシ ョ ン設定およびノードのアクテ ィ ビテ ィ  レート が含まれています。 XPA
ウ ィン ド ウで手動で加えた変更は、 設定ファイルに保存できます。 この設定ファイルは XML

http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=en&ver=13.1&topic=sw+manuals&sub=devref.pdf
http://japan.xilinx.com/support/documentation/dt_ise13-1_tutorials.htm
http://japan.xilinx.com
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フォーマッ ト で、 直前の XPA セッシ ョ ンの関連デザイン情報を次のセッシ ョ ンに読み込むこ

とができます。 

· PCF : オプシ ョ ン ファ イル。PCF (物理制約ファイル) には、 ク ロ ッ ク周波数を決定する と きに

役立つ制約情報が含まれています。UCF (ユーザー制約ファイル) に含まれるク ロ ッ ク情報すべ

てが PCF にレポート されるので、 デザインで十分に制約が設定されている場合は、 消費電力

結果の精度を高めるために PCF を読み込むこ とが重要になり ます。

· VCD または SAIFファ イル : オプシ ョ ン ファ イル。これらのシ ミ ュレーシ ョ ン アクティ ビティ

ファ イルには、 特定のスイ ッチング情報 ( ト グル レート、 信号レート、 および周波数情報) が
含まれているため、消費電力予測の精度がもっと も高くな り ます。 XPA では、 シ ミ ュレーシ ョ

ン ファ イルに含まれるネッ ト とデザインのネッ ト をすべて一致させるこ とができない場合が

あるので、 一部のスイ ッチング情報は手動で入力する必要がある場合があ り ます。 どのデザイ

ン情報が抽出され、 どのデザイン情報が抽出されなかったのかを確認する こ とが重要です。

[Console] タブに表示されている警告メ ッセージに、デザイン情報が XPA に含まれなかったこ

とを示すメ ッセージがある可能性があるので確認してください。

このチュート リ アルでは、バージ ョ ン 13.1 の XPA を使用します。次に、XPA を使用して消費電力

解析を実行する主な手順を示します。 このチュート リ アルには、 Virtex-6 または Spartan-6 デザイ

ンを使用できます。

手順 1 : XPower Analyzer (XPA) の起動

次のいずれかの方法で XPA を起動します。

· ISE から  XPA を起動する場合 : Project Navigator の [Processes] ペインで [Place & Route] の
下の [Analyze Power Distribution (XPower Analyzer)] プロセスをダブルク リ ッ ク します。 .

ISE から  XPA を開く と きは、完全に配置配線が完了しているデザインを解析する こ とにな り

ます。

· XPA をスタンドアロンで起動する場合 : 次を実行します。

a. [スタート ] → [ファ イル名を指定して実行] をク リ ッ ク し、 ダイアログ ボッ クスで 「cmd」
と入力します。

b. コマンド  プロンプ トで 「xpa」 と入力して Enter キーを押します。

http://japan.xilinx.com
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手順 2 : 入力ファイルの指定

XPA をスタンドアロンで起動した場合、 次の方法で入力ファイルを指定する必要があ り ます。

1. [File] → [Open Design] をク リ ッ ク します。

2. [Open Design] ダイアログ ボッ クスで Virtex-6 または Spartan-6 チュート リ アル デザインで使

用するファイルを選択します。

メモ : このチュート リ アルでは、 Virtex-6 デザインを使用します。

¨ Virtex-6 デザイン : 

- V6_tutorial_top_16bit.ncd (配置配線後の NCD ファ イル)

- V6_tutorial_top_16bit.pcf (物理制約ファイル)

- simulation_XPA_stimulus_file.saif (シ ミ ュレーシ ョ ンから出力されたス

ティ ミ ュラス  ファ イル)

¨ Spartan-6 デザイン : 

- S6_tutorial_top_16bit.ncd (配置配線後の NCD ファ イル)

- S6_tutorial_top_16bit.pcf (物理制約ファイル)

図 9 : [Open Design] ダイアログ ボックス (XPA)

NCD ファイル

XML ファイル

PCF フ ァイル

VCD/SAIF ファイル

http://japan.xilinx.com
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手順 3 : 環境設定の入力

XPA を起動して指定の入力ファ イルでデザインを解析した後には、 次のレポート  ビューが表示さ

れます。

· [Summary] ビューには、 すべての重要な電圧レール情報が表示されます。

· このビューに含まれる  [Environment] 表および [Thermal Property] 表では、 デバイスの消費電

力計算で使用される熱情報が表示され、 ハードウェアおよび環境に合わせて熱設定を変更でき

ます (図 10 を参照)。 周囲温度はデフォルトで 50℃ですが、 変更可能です。 また、 カスタムの

ジャンクシ ョ ン温度、 カスタムの Theta JA (ヒート シンクを使用する場合)、およびエアフロー

情報を入力できます。 この熱情報は、 消費電力予測に直接影響します。

· [Summary] ビューには、 各電圧の消費電力 ([Supply Summary] 表) およびスタティ ッ ク電流

(Iccq)/ダイナ ミ ッ ク電流 (Icc) ([Supply Power (W)] 表) も表示されています。 このレポー ト

ビューでは、 各電圧をデバイスのデータシートに記載されている推奨動作条件内で変更できま

す。

· [Default Activity Rates] ビューでは、出力負荷、 ト グル レート、およびイネーブル レート など

の設定をグローバルに変更できます。

XPA で指定の入力フ ァ イルを開いてデザイ ン解析を済ませた場合は、 [Summary] ビ ューの

[Environment] 表で次のよ うに熱設定を変更します。

· [Ambient Temp] = 25°C

· [Airflow] = 250 LFM

· [Heat Sink] = None

XPA にデータを入力した後は、消費電力解析をアップデートする必要があ り ます。アップデートす

るには、 [Tools] → [Update Power Analysis] をク リ ッ ク します。

図 10 : [Environment] 表 ([Summary] ビュー ) : XPower Analyzer (XPA)

http://japan.xilinx.com
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手順 4 : デフォルトのアクテ ィ ビテ ィ  レートの設定

VCD または SAIF ステ ィ ミ ュ ラス  ファ イルがまだ使用できないデザインでは、 [Default Activity
Rates] ビューで異なるデザイン エレ メン トすべてに対して予測されるアクティ ビティ  レート を入

力できます。 ベク ターレス解析エンジンで、 これらの設定がデザインに伝搬されます。

このビューのアクテ ィ ビテ ィ  レー トは、 ベク ターレス伝搬エンジンの初期入力と して使用されま

す。ブロ ッ ク  RAM のイネーブル レートや DSP の ト グル レート など、 [By Resource Type] のエン

ト リ を特定の値に設定する場合は、 [Default Activity Rates] ビューではなく該当する  [By Resource
Type] で変更し、 これらの変更が消費電力解析をアップデート しても保持されるよ うにします。

XPA で設定または値を変更した後は、[Tools] → [Update Power Analysis] で消費電力をアップデー

トする必要があ り ます。

手順 5 : デザイン データの変更

各 [By Resource Type] ビューでは、 XPE のタブのよ うに、 消費電力予測が特定のグループごとに

表示されます。 表示されるコンポーネン トは、 使用するアーキテクチャによって異なり、 また使用

可能なコンポーネン トがデザインで使用されているかによっても異なり ます。 ビューには、 デザイ

ンで使用されるブロ ッ クのみが表示されます。

また、[By Resource Type] ビューでは必要に応じて信号レートやト グル レート を変更するこ と もで

きます。 これらのセクシ ョ ンは XPE のものに類似していますが、 XPA では消費電力予測を変更す

るオプシ ョ ンはあ り ません。 信号を変更する場合は、 デザインに戻って変更する必要があ り ます。

[Details] ビューの下にある  [By Clock Domain] ビューで、すべてのクロ ッ ク周波数が物理制約ファ

イル (PCF) から正し く抽出されているこ とを確認します。インプリ メンテーシ ョ ン前に制約が UCF
(ユーザー制約ファイル) で正し く設定されている場合は、 XPA で PCF から正し く周波数が抽出さ

れます。

図 11 : [Default Activity Rates] ビュー : XPower Analyzer (XPA)

http://japan.xilinx.com
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変更を加えた場合は、 必ず [Tools] → [Update Power Analysis] を再実行してください。

すべての設定が正し く設定される と、[Summary] ビューに解析したデザインに関連する消費電力が

すべて表示されます。

次の 2 つの図では、 XPA で同じ  NCD と設定を読み込み、 ステ ィ ミ ュラス  ファ イルを使用した場

合と使用しなかった場合を比較します。 図 13 では、 情報がベク ターレス予測アルゴ リズムを使用

して予測されています。 図 14 では、 情報がシ ミ ュレーシ ョ ンから抽出された SAIF ファ イルで供

給されています。

図 12 : [By Clock Domain] ビュー : XPower Analyzer (XPA)

図 13 : ベクターレス予測アルゴリズムを使用した場合の [Summary] ビュー : 
XPower Analyzer (XPA)

http://japan.xilinx.com
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チュート リ アルで使用したデザインでは、顕著な差は出ず、ベクターレス  アルゴ リズムを使用して

も比較的近似した消費電力になり ますが、精度の高い結果が必要な場合は、XPA 消費電力解析にデ

ザインのアクティビティを正し く含む SAIF ファ イルを使用して ください。

ザイ リ ンクス  FPGA での消費電力の最適化に関する一般的なガイ ド ラ インは、 ホワイ ト  ペーパー

『Virtex-5 FPGA System Power Design Considerations』 (WP285) を参照してください。この資料は、

Virtexo-6 デバイスでも有効です。

XPA の詳細は、 次のウェブサイ トにある  XPower Analyzer  ヘルプを参照してください。

http://japan.xilinx.com/support/documentation/sw_manuals/xilinx13_1/hh_goto.htm#xpa_c_ov
erview.htm

まとめ

ザイ リ ンクス消費電力ツールを使用する際、 XPE はデザイン前の消費電力予測に、 XPA はインプ

リ メンテーシ ョ ン後のデザインの消費電力最適化に使用します。

これらのツールは、 デザイン フローのさまざまな段階で使用できるので、 次の際に使用できます。

· デバイス選択

· ボード設計

· システムの信頼性

· 特定のデザインにおける消費電力予測

消費電力ツールは、 消費電力の最適化にも使用できます。 電力を最も消費するデザイン箇所を特定

し、 消費電力を削減するためのト レードオフを見つけるこ とができます。 この場合、 ISE の合成お

よびインプ リ メンテーシ ョ ンで使用可能な消費電力最適化アルゴ リズムと合わせて使用できます。

消費電力ツールに正確なデータを入力するこ とが可能な場合、 このチュート リ アルのアドバイスに

従って比較的簡単に正確な消費電力予測を実行できます。

図 14 : シミ ュレーシ ョ ン データを使用した場合の [Summary] ビュー : 
XPower Analyzer (XPA)

http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=white+papers&sub=wp285.pdf
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=white+papers&sub=wp285.pdf
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx13_1/hh_goto.htm#xpa_c_overview.htm
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx13_1/hh_goto.htm#xpa_c_overview.htm
http://japan.xilinx.com
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=white+papers&sub=wp285.pdf
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=white+papers&sub=wp285.pdf
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=white+papers&sub=wp285.pdf
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=white+papers&sub=wp285.pdf
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx13_1/hh_goto.htm#xpa_c_overview.htm
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その他のリソース

• 『ISE Design Suite : インス トールおよびラインセス ガイ ド』 (UG798) : 
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx13_1/iil.pdf 

• 『ISE Design Suite 13 : リ リース  ノート  ガイ ド』 (UG631) :
http://japan.xilinx.com/support/documentation/sw_manuals/xilinx13_1/irn.pdf 

• ザイ リ ンクス資料 : 
http://japan.xilinx.com/support/documentation

• ザイ リ ンクス用語集 : 
http://japan.xilinx.com/support/documentation/sw_manuals/glossary.pdf 

• ザイ リ ンクス  サポート  : http://japan.xilinx.com/support.htm

• XPower Esitimator (XPE) スプレッ ドシート をダウンロードするには、 ザイ リ ンクス  ウェブサ

イ トにある消費電力ソ リ ューシ ョ ン ページを参照して ください。

http://japaninx.com/power 

• このチュート リ アルで使用したデザイン ファ イルは、 チュート リ アル ページからダウンロー

ドできます。

http://www.japan.com/support/documentation/dt_ise13-1_tutorials.htm

• シ リ コン、 ソフ ト ウェア、 IP に関する問題をアンサー データベースで検索したり、 テクニカ

ル サポートのウェブ ケースを開くには、 次のザイ リ ンクス  ウェブサイ トにアクセスして くだ

さい。

http://japan.xilinx.com/support 

• 次に、 このユーザー ガイ ドに関連する資料を示します。 

• 『消費電力手法ガイ ド』 (UG786) 

• 『XPower Estimator ユーザー ガイ ド  』 (UG440)

• 『Seven Steps to an Accurate Worst-Case Power Analysis Using Xilinx Power Estimator
(XPE) 』 (WP353)

• XPower Analyzer (XPA) ヘルプ

• 『Test Boards for Area Array Surface Mount Package Thermal Measurements』 

• FPGA で使用可能な リ ソースの説明は、http://japan.xilinx.com/documentation で参照でき

ます。

http://japan.xilinx.com
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http://japan.xilinx.com/support/documentation/sw_manuals/xilinx13_1/irn.pdf
http://japan.xilinx.com/support/documentation
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=glossary
http://japan.xilinx.com/support.htm
http://japan.xilinx.com/power
http://japan.xilinx.com/support/documentation/dt_ise13-1_tutorials.htm
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http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&ver=13.1&topic=sw+manuals&sub=ug786_PowerMethodology.pdf
http://japan.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=user+guides&sub=j_ug440.pdf
http://www.xilinx.com/cgi-bin/SW_Docs_Redirect/sw_docs_redirect?locale=jp&topic=white+papers&sub=wp353.pdf
http://japan.xilinx.com/documentation
http://www.jedec.org/download/search/jesd51-9.pdf
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